
 

CLASS: VI 

ENGLISH WEEKLY PLAN: ( 17/08/2020- 22/08/2020) 

Topics:   The Cherry Tree – R.K. Narayan 

Diary Entry 

LEARNING OBJECTIVES: 

1. The students will be able to comprehend the story on their own and attempt the related comprehension 

exercises. 

2. Learners will be able to understand the purpose of keeping a diary. 

3. They will be able to describe the format of a diary entry. 

4. The students will be able to create a diary. 

 

Important Points:  ( From the Story) 

Characters- Rakesh and his Grandfather  

Setting - Outskirts of Mussoorie 

Point of view- Third person , narrator or the author is telling the story.  

Theme- Care for animals and plants . It has underlying themes of Struggle, Dedication, Pride, Growth and 

Responsibility  

Mood- Feeling of love for nature and happiness  

Plot- Rakesh plants a seed that faces a lot of difficulties before growing into a cherry tree. 

 

New Words: 

1. stunted- prevented full growth 

2. promptly- immediately 

3.tang- taste or smell that is sharp but pleasant 

4.streaming- moving freely and smoothly 

5.gumboots- rubber boots 



 

6.intention- an aim or plan 

7.tender- showing gentleness 

8.grumpy- bad-tempered and irritable 

9.minivets- small, slender birds with long tails  

10. flitted-  flew around 

Comprehension Exercise: 

I. Read the given extracts and answer the following questions: 

1. ‘Nothing is lucky if you put it away. If you want luck, you must put it to some use.’  

a. Who said this and to whom?   

b. What was the speaker referring to?  

 c. How did the person being spoken to ‘put it to some use?’  

2. ……he could see the mountain striding away into the clouds.  

a. Who is referred to as ‘he’ in this line?  

b. From where could ‘he’ see the mountain?  

c. What does the expression ‘striding away into the clouds’ mean? . 

3. How did Rakesh and his grandfather spend the winter evenings?  

. 4. Rakesh thought that the cherry tree had died on two occasions. Narrate the incident briefly.  

DIARY ENTRY 

Diary entry is an informal and personal form of writing. A diary’ entry can be based on a personal experience, daily 

happenings or any important event of personal or public life. Most of the great men keep diaries in which they record 

their daily happenings and other important activities. In other words, diaries give a glimpse of the past incidents of a 

person’s life. In fact, we come to know about the lives of great people through the information recorded in their diaries.  

Guidelines for Writing a Diary 

 A diary is generally written at night. This way the day’s happenings can be recorded. 

 The language and tone is generally informal and personal. 

 Personal pronouns can be used. 



 

SAMPLE ( DIARY ENTRY) 

Question 1: 
Yesterday it was your first day in your new school. You made new friends. Teachers were good to you and you liked 

the infrastructure of the school. Write about your experiences and feelings about the new school in your diary.  

Answer: 

New Delhi 

20th March, 20XX 

Monday, 8:00 pm 

Dear diary, 

Today, I joined my new school. It was a very nice and exciting. My class teacher was very nice to me. She introduced 

me to the entire class. I sat with Neha, the monitor of the class. She helped me in every way possible. She gave me her 

notebooks, shared her lunch with me. She even helped me with my classwork. 

The best thing I liked about the school was the library. It was big and spacious. I am a passionate reader and I found 

many books of my favourite authors. The computer lab was well equipped with the latest models of computers. 

I look forward to going to school tomorrow. Now, I am not missing my old friends and my old school. Now, I am 

going to sleep as I have to get up early in the morning to get ready for school. 

Babli 

PRACTICE QUESTION: 

Q.1 You are Raju/Ranjana of Salwan Public School, New Delhi. You are motivated by the ‘Clean India Campaign’ of 

the Prime Minister and participated in it in your own way in your colony. Taking help from the input write a diary entry 

on the subject. 

Hints: • PM’s ‘Swachha Bharat Abhiyan’ • motivated millions of youngmen like me • called a meeting of all young 

boys and girls • volunteers • started removing dirt • bought new bins • distributed pamphlets • enlightened public • good 

results • appreciable change in the mindsets • I feel proud of myself and my companions. 

 

Activity: 

 Share your experience with the class regarding the problems faced by you while planting a sapling and how you 

tried to overcome that obstacle.  ( Speaking Activity) 

 

Class 6 Hindi  



 

https://youtu.be/MsrUoFGG_3M- पपप9 

Note- please refer to the above given link to study the chapter 
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Maths Worksheet 
 
Learning Objectives –    
1. Identify the importance of negative numbers in daily life. 
2. Arrange the integers in negative and positive integers in decreasing order. 
3. Add and Subtract the integers 

 
https://youtu.be/nBu7m-EIMa0 

Activity –a. Measure the following objects. Write down their dimensions. 
                b. Draw the shapes of objects also showing the  

dimensions. You can use ruler or measuring tapes. 

                c. Also write whether you can express it as positive or negative integer 

       Objects to be measured– 

1. Length of your Maths register=____ 

Breadth of Maths register= _____ 

2. Length, Breadth and height of 

a.  Refrigerator=____ , ____,  ____ 

b. Your Room 

       3.Length of pencil=____________ 

 

Choose the correct option:-  

Q1 The opposite of 10 km of north is   

a) 20km north  

b) 10km south  

c) -10km south  

d) None  

Q2  The sum of two integers having negative sign is   

a) Zero  

b) Always negative  

c) Always positive  

d) Sometimes negative sometimes positive  

https://youtu.be/nBu7m-EIMa0


 

Q3 Fill in the blank with correct symbol   >,<,,=  

          (-25)-(-42)  ___(-42)-(-25)  

      a)  >                      b) <                  c) =             

Q4 Using the number line, write the integer which is  

a) 3 more than -1  

b) 4 less than 2  

c) 5 more than -2   

d) 3 less than -2  

Q5 Write four negative integers greater than -16.  

Q6 Write five  integers less than -5.  

Q7Draw a number line and answer the following  

a) Which number will we reach if we move 3 steps to the right of -1?  

b) If we are (-5) on the number line, in which direction should we move to reach 3 ?  

Q8 Solve the following  

a) (-19)  + 19  

b) (-24)  +  (-30 )  

c) 280  +  (-170)  

d) 2  +  (-30)  + (-5)  +  5  

e) (-55)  +  (-11)  +  6  +  (-13)  

f) (-24)  - 58  

g) (-7)  - (-3)  + 8  

h) (-10)  +  6  -13  + 6  

i) 35  -  (-16)  + 19  

j) 20  - (-13)  + 11  - (-9)  

Q9 Find the value of  

a) l-5 -2l    

b) - l9  -  4l  

c) l – 11l -  l3l  

d) 15 + l -10 l  

Q10 Give the additive inverse of   

a) -62  



 

b) – 7 +8   

c) 100  

d) - (  - 3 )  

Q11 Using number line solve the following  

 a) ( -3 ) + ( -4 )                       b) (  -6)  +  4  

Q12 Arrange each of the following in increasing order  

a) 3,  -7  ,  10,  -2,   1 ,  0,  -10  

b) 0 ,  2,  -3,  5,   -7,   -1  

Q13 Subtract the sum of 1280 and  (- 675)  from (-419)  

Q14 The sum of two integers is 71, If one of the integer is (-145). Find the other.  

Q15Write all the integers between the given pairs (in increasing order)  

(a)-3 and 0 (b) -4 and 2 ( c) -5 and -1 (d) -50 and -35  

Q16 Write the opposite of following numbers as integers with appropriate signs:  

(a) A gain of Rs. 2000.  

(b) A loss of Rs. 500. ( c) 150c above 00c.  

(d) 90c below 00c  

(e) 100 Km. above sea level  

(f) 5m. fall into a pit dug in the ground.  

 

Fill in the blanks : 

1. Circles having different radii but the same centre are called __________________  

2. Radius is ________________ of the diameter.  

3. The diameter of a circle is the ________________chord of the circle.  

4. The Perimeter of a circle is called the _____________________.  

5. A quadrilateral has ____________ diagonals.  

6. A triangle has __________________elements.  

7. The interior of an angle together with the angle (boundary) itself is   called the _______  

8. In PQR, the side opposite to P is _______________  



 

9. Length of a diameter is _________________the radius of  a circle.  

10. All the radii of a circle are ____________________  

Choose the correct answer : 

1. The centre of a circle     

i) Lies in its interior  ii)lies in its exterior 

iii) Lies on the circle  iv) none of these  

2. In quadrilateral PQRS, the two diagonal are 

i) PQ and RS   

ii) PRand RS  

iii) PS and PR  

iv)  PR and QS  

3. In the figure, the angle can be named as  

 i)Angle OPQ  ii)  Angle POQ  iii) Angle PQOiv) Angle QPO 

 

O        Q 

 

4. A line segment joining any two points on the circle is called a ________________   

 (i) radius   (ii) diameter  (iii) chord   (iv) secant  

 

5. A closed figure bounded by three or more segments is called a ____________  

 Curve        (ii) Polygon          (iii)Circle     (iv) None of these   

6. A line intersecting a circle at two different points is called a __________________of a circle. 

(i) diameter     (ii) Radius        (iii) secant     (iv) centre 

 

7. A closed figure formed by joining three non-collinear points is called  

(i) a triangle         (ii) an angle       (iii) a curve     (iv) none of these   

8. An Angle has  

(i) One vertex and one arm  

 
P  



 

(ii) One vertex and two arms  

(iii)Two vertex and two arms  

(iv)None of these  

9. A circle is  

(i) a polygon        (ii) an open curve  

(ii) a closed curve (iv) none of these  

10. A Point equidistant from all the Points on a circle is called the   _____________of the circle.  

(i) Centre         (ii) Radius         (iii) diameter         (iv)None of these  

 

11.Write all factors of each of the following numbers. 

(i) 24                    ii) 300                (iii) 225 

12.Write first five multiples of each of the following numbers 

(i) 12                   ii) 36                   (iii) 18 

13.Write all prime numbers between 

(i) 20 and 40                                  (ii) 80 and 100 

14. Express each of the following numbers as the sum of two odd primes 

(ii) (i) 45                  (ii) 39                    

15. Express each of the following numbers as the sum of three odd primes 

(iii) (i) 63                  (ii) 53                    (iii) 15 

16.Express each of the following as the sum of twin primes 

(iv) (i) 36                 (ii) 84 

17. Find prime factorization of each of the following numbers 

(v) (i) 1331              (ii) 1024                   (iii) 148  

 

Science Worksheet 
Class-VI 

Chapter: Fibre to Fabric 
https://youtu.be/q68kIdOnEtk 

https://youtu.be/q68kIdOnEtk


 

Learning Outcomes: 

• To study different types of clothing materials. 

• To understand the concept of fibres, fabric and yam. 

• To know different sources to get fibres. 

2 Introduction 

All cloth materials are made up of long, narrow, thin structures called fibres. Fibres are obtained from natural as well as man-
made sources. 

 

Natural Fibre Synthetic Fibre 

Natural fibres are fibres that are found in nature. 
Ex: Woo, Silk and Cotton etc. 

These fibres are manmade or simply prepared in 
lab. Ex: Nylon, Teflon etc. 

They are good absorbents and so able to absorb 
heat, temperature, cold, sweat etc. depending on 
conditions and nature of fibres. 

They do not have such pores as they are made up 
of chemical and so do not act as good absorbents. 

Comfortable in use. Not as comfortable as natural fibres. 

Their length is naturally obtained and it is not 
possible to change the fibre structure. 

Their lengths can be controlled by man and the 
fibres can easily be changed to different 
structures. 

 

3 Natural Fibres 
Natural fibres are fibres that are found in nature. There two main sources of natural fibres: 

1. Plant Fibres 

2. Animal Fibres 

3.1 Plant Fibres 

All the plants have fibres in their body structure, e.g., cotton and mango have fibres on their seed, coconut on its fruit, jute in its 
stem and banana tree in its leaf. The fibres obtained from these sources are called plant fibres. 

2.1.1 Cotton 

Cotton plants are grown in fields usually at places having a warm climate and black soil. Some cotton producing Indian states 
are Punjab, Gujarat, Madhya Pradesh, Karnataka, Maharashtra etc. Cotton plants bear fruits the size of a lemon called Cotton 
Balls which burst open upon maturing and the seeds wrapped up in cotton fibre become visible. Cotton is generally picked by 
hand from these balls. 



 

 

1 

 2 

 

Figure 1: A field of cotton 

Ginning: Ginning of cotton can be defined as the process of separating cotton fibres from cotton seeds. Traditionally, ginning 
used to be done by hand but these days machines called double roller cotton ginning machines are widely in use. 

 

Figure 2: Ginning of cotton 



 

Test your learning: 

Question 1: Classify the following fibres as natural or synthetic: nylon, wool, cotton, silk, polyester, jute. 

Question 2: State whether the following statements are ‘true’ or false’: 

(a) Yam is made from fibres. 

(b) Spinning is a process of making fibres. 

(c) Jute is the outer covering of coconut. 

(d) The process of removing seeds from cotton is called ginning. 

(e) Weaving of yam makes a piece of fabric. 

(f) Silk fibre is obtained from the stem of a plant. 
(g) Polyester is a natural fibre. 
 

Question 3: Fill in the blanks: 

(a) Plant fibres are obtained from _____________________ and _____________________. 
(b) Animal fibres are _____________________ and _____________________. 

 

 3 

Question 4: Explain the process of making yam from fibre. 

Question 5: Name two items that are made from coconut fibre. 

Question 6: What type of soil is used to grow cotton plants? 

Activity: 

Question 1: Take any two pieces of fabric. Pull the threads of the fabric and try to guess what it is made of. Paste the piece of 
fabric and the pulled-out threads on a piece of paper and answer the following questions: 

(a) What is the fabric made of? 

(b) Is it natural or synthetic fibre? 

(c) What is the source of the fibre? 

Science Worksheet 
Class-VI 

Chapter: Fibre to Fabric 
https://youtu.be/q68kIdOnEtk 

https://youtu.be/q68kIdOnEtk


 

Learning Outcomes: 

• To study different types of clothing materials. 

• To understand the concept of fibres, fabric and yam. 

• To know different sources to get fibres. 

4 Introduction 

All cloth materials are made up of long, narrow, thin structures called fibres. Fibres are obtained from natural as well as man-
made sources. 

 

Natural Fibre Synthetic Fibre 

Natural fibres are fibres that are found in nature. 
Ex: Woo, Silk and Cotton etc. 

These fibres are manmade or simply prepared in 
lab. Ex: Nylon, Teflon etc. 

They are good absorbents and so able to absorb 
heat, temperature, cold, sweat etc. depending on 
conditions and nature of fibres. 

They do not have such pores as they are made up 
of chemical and so do not act as good absorbents. 

Comfortable in use. Not as comfortable as natural fibres. 

Their length is naturally obtained and it is not 
possible to change the fibre structure. 

Their lengths can be controlled by man and the 
fibres can easily be changed to different 
structures. 

 

5 Natural Fibres 
Natural fibres are fibres that are found in nature. There two main sources of natural fibres: 

3. Plant Fibres 

4. Animal Fibres 

5.1 Plant Fibres 

All the plants have fibres in their body structure, e.g., cotton and mango have fibres on their seed, coconut on its fruit, jute in its 
stem and banana tree in its leaf. The fibres obtained from these sources are called plant fibres. 

2.1.1 Cotton 

Cotton plants are grown in fields usually at places having a warm climate and black soil. Some cotton producing Indian states 
are Punjab, Gujarat, Madhya Pradesh, Karnataka, Maharashtra etc. Cotton plants bear fruits the size of a lemon called Cotton 
Balls which burst open upon maturing and the seeds wrapped up in cotton fibre become visible. Cotton is generally picked by 
hand from these balls. 
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Figure 1: A field of cotton 

Ginning: Ginning of cotton can be defined as the process of separating cotton fibres from cotton seeds. Traditionally, ginning 
used to be done by hand but these days machines called double roller cotton ginning machines are widely in use. 

 

Figure 2: Ginning of cotton 



 

Test your learning: 

Question 1: Classify the following fibres as natural or synthetic: nylon, wool, cotton, silk, polyester, jute. 

Question 2: State whether the following statements are ‘true’ or false’: 

(h) Yam is made from fibres. 

(i) Spinning is a process of making fibres. 

(j) Jute is the outer covering of coconut. 

(k) The process of removing seeds from cotton is called ginning. 

(l) Weaving of yam makes a piece of fabric. 

(m) Silk fibre is obtained from the stem of a plant. 
(n) Polyester is a natural fibre. 
 

Question 3: Fill in the blanks: 

(c) Plant fibres are obtained from _____________________ and _____________________. 
(d) Animal fibres are _____________________ and _____________________. 
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Question 4: Explain the process of making yam from fibre. 

Question 5: Name two items that are made from coconut fibre. 

Question 6: What type of soil is used to grow cotton plants? 

Activity: 

Question 1: Take any two pieces of fabric. Pull the threads of the fabric and try to guess what it is made of. Paste the piece of 
fabric and the pulled-out threads on a piece of paper and answer the following questions: 

(d) What is the fabric made of? 

(e) Is it natural or synthetic fibre? 

(f) What is the source of the fibre? 

 

SOCIAL SCIENCE STUDY MATERIAL 

TOPIC: MOTIONS OF THE EARTH 

Video link-https://youtu.be/FB3AMvxXLDA 

https://youtu.be/FB3AMvxXLDA


 

LEARNING OBJECTIVES- 

Students will be able to- 

 Understand two motions of the earth and their effects 

KEYWORDS- 

 Rotation: the spinning of the earth on its own axis once in every 24 hours 

 Revolution: the motion of the earth around the sun in a fixed orbit in 365 ¼ days or one year 

 Circle of illumination: the circle that divides the day from night on the globe 

 Leap year: a year occurring once every four years which has 366 days including 29 February 

 Elliptical orbit: when an object moves around another object in an oval shaped path 

THE TWO MOTIONS 

 Rotation is the movement of the earth on its own axis. The movement of the eartharound the sun in a fixed path or orbit is 

called revolution. 

 The circle that divides the day from night on the globe is called circle of illumination. The circle takes about 24 hours to 

complete one rotation around its axis. The period of rotation is known as earth day. This is the daily motion of the earth. 

 It takes 365¼ days for earth to revolve around the sun. We add 6 hour of each year to every fourth year, which makes it a 

complete 1 day and it is added to the month of February. This year is called leap year and it has 366 days. 

WHAT WOULD HAPPEN IF THE EARTH DID NOT ROTATE? 

The portion of the earth facing the sun would always experience day, thus bringing continuous warmth to the region. The other 
half would remain in darkness and be freezing cold all the time. 

 

 



 

 

SUMMER SOLSTICE 

On 21st June, the Northern Hemisphere is tilted towards the sun. The rays of the sun fall directly on the Tropic of Cancer. As a 

result, these areas receive more heat. The areas near the poles receive less heat as the rays of the sun are slanting. The North Pole 

is inclined towards the sun and the places beyond the Arctic Circle experience continuous daylight for about six months. Since a 

large portion of the Northern Hemisphere is getting light from the sun, it is summer in the regions north of the equator. The 
longest day and the shortest night at these places occur on 21st June. At this time in the Southern Hemisphere all these conditions 

are reversed. It is winter season there. The nights are longer than the days. This position of the earth is called the Summer Solstice 

 

WINTER SOLSTICE 

On 22nd December, the Tropic of Capricorn receives direct rays of the sun as the South Pole tilts towards it. As the sun’s rays fall 

vertically at the Tropic of Capricorn (23½° S), a larger portion of the Southern Hemisphere gets light. Therefore, it is summer in 
the Southern Hemisphere with longer days and shorter nights. The reverse happens in the Northern Hemisphere. This position of 

the earth is called the Winter Solstice. 



 

 

EQINOX 

On 21st March and September 23rd, direct rays of the sun fall on the equator. At this position, neither of the poles is tilted towards 
the sun; so, the whole earth experiences equal days and equal nights. This is called an equinox. On 23rd September, it is autumn 

season in the Northern Hemisphere and spring season in the Southern Hemisphere. The opposite is the case on 21st March, when 

it is spring in the Northern Hemisphere and autumn in the Southern Hemisphere. 
 

WORKSHEET 

I. Fill in the blanks:- 

1. A leap year has _____ number of days. 

2. The daily motion of the earth is _____ 

3. The earth travels around the sun in_____ 

4. The sun’s rays fall vertically on the Tropic of_____ on 21st June. 

5. Days are shorter during _____. 

II. Tick the correct answers:- 

1. The movement of the earth around the sun is known as 

(a) Rotation   (b) Revolution   (c) Inclination 

 

2. Direct rays of the sun fall on the equator on 

(a) 21 March    (b) 21 June    (c) 22 December 

 

3. Christmas is celebrated in summer in 

(a) Japan    (b) India   (c) Australia 



 

 

4. The cycle of the seasons is caused due to 

(a) Rotation   (b) Revolution   (c) Gravitation 

 

5. The earth revolves around the sun in a_____ orbit. 

(a)elliptical orbit  (b) round   (c) straight 

III. Match the following:- 

 

IV. Give answer for the following questions:- 

1. Define rotation and revolution 

2. Differentiate between summer and winter solstice 

3. Why do the poles experience 6 months day and six months night? 

4. How does a leap year occur? 

5. What is an equinox? 

V. Complete the following words (to enjoy):- 

 R_t_t_o_ 

 E__in_x 

 Eq_at__ 

 R_v_l_ti_n 

 S_ls_i_e 

ACTIVITY 

 From your local newspaper record the timings of sunrise and sunset at your place for a week and find out how the length 

of the days of a week from day to day. 

OR 

 Take a ball/globe and a candle/torch. Now mark a point- town X on the ball and place it in such a way that town X is in 

darkness. Now rotate the ball from left to right. As you move the ball slightly, the town will have its sunrise. As the ball 

continues to move, the point X gradually gets away from the sun. This is sunset. 



 

 

पपपप – पपपपपपप 

पपपपप -VI  

 

 

Link -    https://youtu.be/u0_mPRPtg-g 

 

 

https://youtu.be/u0_mPRPtg-g
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Computer 



 

Video link: https://www.youtube.com/watch?v=GdBuBkJh7JE 
 

Microsoft PowerPoint 2010 Basics 
 
 
 

6 What is Microsoft PowerPoint 2010? 

Microsoft PowerPoint is part of the Microsoft Office suite of programs. It can be one of your most powerful 

tools for communicating ideas and information during presentations. In PowerPoint, you are able to place 

your content into a series of "slides" which can then be projected for your audiences, printed and distributed 

as handouts, or published online using different file formats. 

7 Getting Started 
 

Let’s open Microsoft PowerPoint. You can do this by clicking on the Start Icon, 

All Programs > Microsoft Office> Microsoft PowerPoint. 

7.1 The PowerPoint Window 
 

 

https://www.youtube.com/watch?v=GdBuBkJh7JE


 

 
7.2 The Microsoft Office File Tab 

In the upper-left corner is the Microsoft Office file tab. When you click the tab, a menu appears. This feature is 
called the Backstage View. You can use the menu to create a new file, open an existing file, save a file, and 
perform many other tasks. You can also open a new or recent presentation, preview and print, and more from 
this tab. 

7.3 The Quick Access Toolbar 

 

Above the File tab is the Quick Access toolbar. The Quick Access toolbar provides you with 
access to commands you frequently use. Most common actions like, Save, Undo, and Redo appear on the 
Quick Access toolbar. You use Save (Ctrl S) to save your file, Undo (Ctrl Z) to rollback an action you have taken, 
and Redo (Ctrl Y) to reapply an action. You can customize this toolbar by selecting the dropdown icon next to 
it, or accessing it through File > Options > Quick Access Toolbar. 

 
7.4 The Title Bar 

 

The Title bar is located at the top in the center of the PowerPoint window. 
The Title bar displays the name of the presentation on which you are currently working. By default, 
PowerPoint names presentations sequentially, starting with Presentation1. When you save your file, you 
can change the name of your presentation and the name will then display in the Title bar. 

 

7.5 The Ribbon 

 

 

WORKSHEET-1 

1. ________ shortcut key is used for creating new presentation.(Ctrl+M/Ctrl+N) 
2. ____________ shortcut key is used to start slide show.(F5/Shift+F5). 
3. Slide show view is used to view ___________ slide at one time.(one/many) 
4. Tables contains ___________ & _________________. 



 

5. PowerPoint is used for creating ________________. 
6. MS PowerPoint is a part of _______________. 

  

  



 

Viewing the Ribbon 

 

You can open or close the ribbon simply by clicking on the 
arrow located next to the help button on the top right. 

Zoom Slider 
 

On the bottom right of the window you will find the Zoom Slider. Clicking or dragging the 
slider arrow or + /- 

icons with your mouse will enlarge or shrink the size of the slide in your window. 
 
 

 

Viewing Pane 
 

Also notice the four icons to the left of the slider. These are shortcuts to the normal, 
sorter, slideshow, or 

reading pane view of your presentation. 

Making a Slide Show 

Slide 1: Title Slide 
 

The first slide will be the Title Slide. You will notice, in the lower left corner of 
the screen, Slide 1 of 1 is indicated. We are going to create a presentation on 
how to make a peanut butter and jelly sandwich. 

Click in the Click to add title box. To insert a title, just type it in: How to Make a Great 
PBJ 

Now, click in the second box and type: 
 

A Gourmet Recipe (tap the Enter key) From (tap the Enter key) Your Name 

 
Saving your work 
 

 To save, click on the File tab. Your first save will prompt 

you to name your file, choose a location, and define the file format type (aka “Save 
As”). By default you save in the latest PowerPoint version. Choosing to save in an 
older format can be done by selecting from the dropdown menu that is offered. 
After you make your selection, click Save. Notice the name will now appear in your 



 

title bar. 

Inserting a New Slide 
 

Let’s add slide 2. From the Ribbon choose the Home tab > Slides > New Slide. 

 

 
Slide 2: Title and Content Slide 

Click in the Click to add title box and type: Ingredients. 

 

Click in the bulleted  Click to add text box and type: 

 

 
 

 

Inserting Animated Images 

In PowerPoint 2010 you can add images that 
move! These are called animated images. You 
can insert an animated Clip Art image on any 
slide. You can move and size the image as you 
desire. To do this you’ll need to click-on Insert in 
the Ribbon, and then click-on Clip Art. A new 
task pane will open up on the right of your 
screen. 

 

On the Ribbon, go to Insert > Clip Art. You can 
limit the search through the drop down box in 
the clip art pane and only check “video”. 

 
 

This image gives specifics on the clip art picture you chose. If this is an animated 
image, you will see the animation moving in the left preview area. 
When you are finished looking at Preview/Properties, click on the Close 

button in the lower right corner. 
 

Viewing your Slide Show 
You have just completed the first stage of your presentation. Go back to Slide 1 and 
click on it. It will indicate Slide 1 of 7 in the status area in the lower left corner of 
your screen. You should recognize this slide as your first slide on “How to make a 
Great PBJ”. 
If you would like to view how your slide show will look when you project it onto a 
screen or monitor, go to the Ribbon at the top and click on Slide Show Tab, then 



 

click on From Beginning in the first group (Start Slide Show). 
 

Or, you can click-on the small Slide Show 
button in the button bar at the lower right of 
the screen. 
There are several ways to advance through your slide show. You can tap the space 
bar, tap the Enter key, tap the right arrow key, or click the left mouse button to 
move forward from one slide to the next during the show. When you get to the end 
of the show, the presentation will return to your slides if you continue to click. 
Anytime you want to end the show, simply tap the Esc key in the upper left corner 
of the keyboard or click the right mouse button and click on End Show in the pop 
up menu that appears. If you end your show early you will be on the slide you were 
viewing when you tapped Esc or clicked-on End Show. 

To go backward to a previous slide in your show, you can tap the Backspace key, or 
the left arrow key. If you are using the mouse to click through your presentation and 
desire to go back, click the RIGHT mouse button and you will see a menu screen 
appear that allows you to choose a Previous slide or Go to any slide. 

WORKSHEET-1 
1.Shortcut key to insert new slide is _________(Ctrl+N/Ctrl+M) 

2.____________is a slide that stores the information about the themes applied.(Slide 

Master/Master Slide) 

3.The ________ dot beside a selected picture is used to rotate it.(red/green) 

4.To animate a slide,click on ____________tab.(animations/transitions) 

5.____________is a graphic way to represent your text in different layout and 

styles.(themes/smart art) 

6.____________tab is used to apply themes to the slides.(insert/design) 

7.If you want to add an effect that makes an object moves in a specified pattern, select the 

effect from the ______________(Entrance/Motion Paths). 

8.Animation means to add  a _________ effect to the slide or the objects of the slide. 

9.MS Power Point is a part of ___________office. 

10.You can make your presentation more attractive by inserting ________. 

11.Powerpoint is a software program that enhance ________________. 

12.A clip art is a single file including ___________,__________,____________ or 

___________. 
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